NMBL Image-to-Model Pipeline 1.0 Alpha Manual
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Installing and Running NMBL Pipeline
Unpack the latest .zip from https://simtk.org/home/nmblslicer and run slicer2-win32.exe.

The Anatomy of NMBL Pipeline
The Menu Window
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The Viewer Window
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The upper part of the Viewer window is the 3D Viewer while the lower part is the 2D Viewer.  To rotate the 3D view, click and drag the left mouse button.  To zoom in or out in either the 3D or the 2D Viewer, click and drag the right mouse button.  To translate the data in either the 3D or the 2D Viewer, click and drag the middle mouse button.

The Tk Console Window
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You can type Tcl commands in this window to do many general tasks, such as creating VTK objects and converting between file formats.

Loading Non-DICOM Data
1. In the Menu window, click Add Volume.

2. Click Browse…
3. Navigate through directories until you find the directory containing your image data.

4. Click on the first file in the series of image files.

5. Click Open.

6. Optionally, you may change the name of the volume of data you are about to load.

7. Optionally, you may provide a description of the volume as well.

8. Click Apply.

9. The data should load, and cross sections from three orthogonal views are displayed in the 2D Viewer.

Loading DICOM Data
1. In the Menu window, click Add Volume.

2. Next to the Properties: label, click on the button showing Basic.

3. In the menu that pops up, click Dicom.

4. Click Select DICOM Volume.

5. Navigate through directories until you find the directory containing your image data.

6. Click on that directory.

7. Click OK.

8. A window pops up labeled List of DICOM Studies.

9. The box labeled Files contains a list of all the images in the volume.

10. Click the Preview button to see a list of icons of all the images.

11. Select or deselect images as desired.

12. When finished selecting which images to load, click OK.

13. Optionally, select a name for the volume of data you are about to load.

14. Click Header.

15. Click Apply.

16. The data should load, and cross sections from three orthogonal views are displayed in the 2D Viewer.

Unloading a Volume
In the Data panel, every loaded volume is listed in the box labeled MRML File Contents (Current Scene):.  To unload a volume, simply right-click the name of that volume in this box, and click Delete in the menu that pops up.

Loading and Saving Scenes

In general it is easiest if you save and load entire scenes rather than individual volumes, so that any registration you did, and any combination of models and data that you had previously set up will be easily loadable later.  The description of the current scene is in the Data panel of the Menu window in the box labeled MRML File Contents (Current Scene):.  You can save the current scene as a .xml file by clicking on the File submenu and choosing Save Scene As….  You can load a scene by clicking on the File submenu and choosing Open Scene….

Manual Registration

To register two images manually, use the following steps.  If you haven’t already, load the two images one after another using the instructions above.  Then in the Data panel of the Menu window, the box labeled MRML File Contents (Current Scene):, note that the two images’ names appear.  Click on the first image’s name.  Then click the Add Transform button.  Then click on the Alignments button in the Main menu.  In the Viewer window, be sure that the Or: values for the 2D Viewer windows are Axial, Sagittal, and Coronal (you can ensure this by clicking on the Or: button and choosing AxiSagCor in the menu that drops down).  Now, you may translate or rotate the first image relative to the second image using the scroll bars in the Alignments panel.  Or, you may click on the Translate or Rotate buttons in the Alignments panel and then click and drag the first image relative to the second image by hand in the 2D Viewer itself. 

Manual Segmentation
Open the Editor panel by clicking the Editor button in the Main menu.

Type in a name for the volume representing the segment slices you will make.

Click Start Editing.

Select the active slice window in which you want to draw segments.  By default this is the window with a red label that shows the “AxiSlice” view in the Viewer window.  You can change the “AxiSlice” to “SagSlice” if you will be segmenting in the sagittal plane, or to “CorSlice” if you will be segmenting in the coronal plane.  Simply click the red label and select the view of your choice in the menu that pops up.  IMPORTANT: You must change the Active Slice to Yellow if you will be segmenting in the window with a yellow label, and similarly for the green window.  Forgetting to specify which slice window you will be segmenting in can result in strange behavior by NMBL Pipeline!

Click Draw2.

In the Menu window, in the View submenu choose 1x512 to select the best view for segmenting.

To plot a control point on a slice in the active window, simply click the left mouse button at the desired location in the window.  Continue clicking to plot successive control points.  As points are plotted, a green Catmull-Rom spline (a popular type of cardinal spline) is automatically interpolated through those points.  You can also click and drag the mouse to plot several closely spaced control points.

Note the buttons labeled Draw, Select, Move, and Insert.  By default, Draw is selected.

If Insert is selected, then you can click on the active window and a new control point will be inserted between the nearest control point and the nearer of its two neighbors to the point where you clicked.

If Select or Move is selected, then NMBL Pipeline will automatically toggle between these modes depending on the mouse position.  Select/Move mode allows the user to select and move control points while the spline contour changes interactively.  The Edit: buttons are self-explanatory: they consist of the operations Cut (CTRL+X), Copy (CTRL+C), Paste (CTRL+V), Select All (CTRL+A), Delete All (CTRL+D), Delete Selected (DELETE), and Deselect All.  The Viewer window must be active when you use these shortcut keys, or they will do nothing.

When done plotting all desired control points, click the Apply button.  This creates a label map that will become the slice data for the volume that will be constructed later.  To control the density of points sampled from the spline contour, simply change the number in the Density field and press Enter.  A value of zero means only the control points plotted by the user will be used in model construction.  A value of d ( 1 means that in addition to the control points, d points will be sampled from each segment of the cardinal spline.  By default, d = 3.  If you wish to draw only a polygon and no spline, you can turn the spline off entirely by clicking No for the Show Spline: option.  Clicking No will automatically change the Density field to zero.

Point the mouse cursor at the “AxiSlice” label.  This will pop up a scroll bar that you can click or drag to move between slices.  Segment every slice.  Then follow the instructions below to construct a 3D model from the slice-by-slice segmentation.  To modify a contour you already applied, go to the slice the contour is on and click Unapply.  If you have more than one contour applied on that slice, repeatedly click Unapply to scroll through the contours until you unapply the contour you want to change or remove.  Then modify the polygon and click Apply when you are done.  To delete a polygon you applied, simply click Unapply repeatedly to scroll to the polygon, click Delete All from the Edit: menu, and then click Apply.  (You can also clear a set of pixels by simply applying a polygon over them that has a black color, but this will not delete the underlying polygon(s), and will in fact add a new black polygon to the stack.)

NMBL users will want to click the Yes button for the Clear Labelmap Before Apply: option.  This will clear the underlying contours and reapply each polygon each time the Apply button is clicked.  SPL users will usually want to leave this option as No, its default state, which ensures that any highlighted pixels obtained from some operation not involving polygons (e.g. the thresholding tool) is never cleared by a simple Apply click.

If you will be drawing many similar polygons on a sequence of images, you may want to select No for the Delete Points After Apply: option.  This will ensure that even after the Apply button is clicked, the polygon you drew is still available for editing even without you having to click Unapply.

NOTE: if you unapply a polygon and then draw and apply a new polygon without reapplying the original polygon, your original polygon will be replaced by the new polygon because the original polygon was not reapplied!

You can choose to have each contour be either Open or Closed, and for each to be made up either solely of Points, or of lines, in which case you click the Polygon button.

You may also segment multiple viewing directions.  However, note that the contours you draw will be much more jagged since the spacing between pixels tends to be much larger in viewing directions other than the primary one.

To create multiple segmentations at once, you can color code each set of contours.  For example, you could draw one pink contour and one blue contour on every slice, and then have all of the pink contours be one segmented structure and all of the blue contours be another segmented structure.  You can choose the color of any contour before or while you draw it by clicking on the Output: button and clicking on the box with the color of your choice in the dialog box that pops up.

FOR FAST SEGMENTATION: Use the shortcut keys above for Select All, Copy, etc.  Also, use the Up arrow for Apply, the Down arrow for changing between the Draw, Select/Move and Insert modes, and the Right/Left arrows to scroll through the slices in the active window.  Remember, these shortcut keys will do nothing unless the Viewer window is currently active!

IF THE APPLIED POLYGONS ARE BLOCKING YOUR VIEW OF THE IMAGE UNDERNEATH: Either click the peek under labelmap button to toggle the applied polygons on and off, or use the shortcut key “g” to do a similar operation of turning the segmentation on and off.
Model Construction
1. Open the ModelMaker panel by clicking the ModelMaker button in the Main menu.

2. Select the volume representing your segmentation (and NOT the volume representing the data that you loaded, which is often selected by default).

3. Type in a name for the 3D model you will now create.

4. Change the smooth and decimate parameters if you wish.

5. Click Create.

6. A model will be generated and displayed in the Viewer window.

Adjusting the Window/Level
1. Open the Volumes panel by clicking the Volumes button in the Main menu.

2. Click on the Display tab.

3. Select an active volume whose window/level you will adjust.

To manually adjust the window/level:

Click and drag the sliders.  Adjust the level value so that the dark areas become barely visible.  Then adjust the window value so that the bright areas are not saturated into white.  You may need to go back and forth adjusting values until you have an optimal display of your data.

To automatically adjust the window/level:

Click Auto.

Image Fusion

Use the Fade vertical slider in the lower portion of the Menu window to fade from the images displayed in the background layer (Bg) to the images displayed in the foreground layer (Fg).  This is useful, for example, for checking alignment or coverage of a segmentation.

Adjusting the Viewing of 3D Models

1. In the Models panel, click on the Display tab.

2. Click Show All to display all models in the 3D Viewer.

3. Click Show None to display none of the models in the 3D Viewer.

4. Click the name of a model in the list to turn its visibility on and off.

5. Right-click the name of a model in the list to display a menu of display options.

6. Move the Opacity slider next to a model to adjust its transparency.

Saving Volumes

1. In the Editor panel, click on the Volumes tab.

2. Click Save.

3. From the menu, select the label map to save and click Save.

4. The Save Volume dialog box appears.

5. Select and/or type in the path and the filename prefix (e.g. “Working”).

6. Choose .pts to save the RAS coordinates (in millimeters) of the points in a segmentation.

7. Or, choose Standard to save 3D models or segmentations in Slicer’s standard form.

8. Click Save.

Saving Models

1. In the ModelMaker panel, click on the Save tab.

2. From the menu, select the model to save and click Save.

3. The Save Model dialog box appears.

4. Select the path and click Save.

5. The model will be saved as a .vtk file, which is in vtkPolyData format.

Exporting Slicer Models to Geomagic Studio to SIMM
To convert a Slicer model into something SIMM can read, the preferred strategy is:

1. Convert the Slicer .vtk model file into a STL file.
2. Read the STL file into Geomagic Studio.
3. Process the model in Geomagic Studio to smooth its surfaces.

4. You can read multiple models into Geomagic Studio and try to merge them into one model.

5. Save the processed Geomagic Studio model as an OBJ file.

6. Read the OBJ file into SIMM.

Please consult the Geomagic Studio and SIMM manuals for information on steps 2-6.  The instructions for step 1 are as follows.  To convert a Slicer model file model.vtk into a STL file newmodel.stl, first make sure you are in the directory that contains model.vtk by typing "cd " and the name of the directory and pressing enter. Then type the following commands into the Tk Console window, pressing enter after typing each command:
vtkPolyDataReader pdr
pdr SetFileName model.vtk
vtkCleanPolyData clean
clean SetInput [pdr GetOutput]
vtkTriangleFilter triangles
triangles SetInput [clean GetOutput]
vtkSTLWriter pdw
pdw SetFileName newmodel.stl
pdw SetInput [triangles GetOutput]
pdw SetFileTypeToBinary
pdw Write

You should now have a STL model file called newmodel.stl in the current directory.  You can read this file into Geomagic Studio.

Converting a Slicer Mesh File into a SimTK Mesh File

Suppose you want to create a SimTK mesh file out.vtp containing the same data as a Slicer mesh file in.vtk.  In the Tk Console window, type the following commands, pressing enter after typing each command:

vtkPolyDataReader pdr

pdr SetFileName in.vtk

vtkCleanPolyData clean

clean SetInput [pdr GetOutput]

vtkTriangleFilter triangles

triangles SetInput [clean GetOutput]

vtkXMLPolyDataWriter pdw

pdw SetFileName out.vtp

pdw SetInput [triangles GetOutput]

pdw SetDataModeToBinary

pdw Write

Loading Models

1. In the Data panel, click Add Model.

2. Click on the Props tab.

3. To find the model file, click Browse…
4. A dialog box appears.

5. Select the model you would like to load and click Open.

6. Optionally, select a name for the model.

7. From the Color pull-down menu, select the model’s color as it will appear in the 3D Viewer.

8. Click Apply.

Measurements

In this section, we will show how to plot three points P0, P1, and P2 on a volume, measure the distance between P1 and P2, and measure the angle between P0, P1, and P2.

1. In the Modules submenu, choose Registration and click on Fiducials to open the Fiducials module.

2. Click on the Edit tab.

3. In the Create a Fiducials List field, type the name for the list of points you will mark.

4. Press Enter.

5. In the 3D Viewer: move the mouse to the first point P0 you want to mark and press the “p” key.

6. Move the mouse to the second point P1 you want to mark and press “p”.

7. Move the mouse to the third point P2 you want to mark and press “p”.  As you plot each point, its symbolic name appears in the Menu window.

8. In the Modules submenu, choose Measurements and click on Measure to open the Measure module.

9. Click on the title bar of the Viewer window.

10. Point the mouse at P0 and press the “q” key.  P0 turns blue, meaning it is deselected.  Now only P1 and P2 are red, which means they are the only selected points.

11. Click the Measure button and choose Distance from the menu that drops down.  The distance between P1 and P2 is shown in the box below the Measure button.

12. Click on the title bar of the Viewer window.

13. Point to P0 and press “q” to select P0 again.  Now all three points P0, P1, and P2 should be red.

14. Click the Measure button and choose Angle from the menu that drops down.  The angle determined by the points P0, P1, and P2 is shown in the box.

You can go back to the Fiducials module to add more points to your list, or to create a new list of points, or to remove points from your list (by pointing at a point and pressing the “d” key).  In the Measure module, you can also compute the Position of a point, the Intersection point of two lines determined by four coplanar points, the Volume enclosed by four or more points, and the Surface Area of the volume enclosed by four or more points.

The 3D Slicer

NMBL Pipeline is simply a version of NA-MIC’s 3D Slicer customized for the NMBL group at Stanford.  Every effort is made to keep NMBL Pipeline and Slicer functionally the same.  The main differences we expect between NMBL Pipeline and Slicer is that NMBL Pipeline will contain fewer modules than Slicer, since we want NMBL Pipeline to be the smallest, simplest piece of software that meets the needs of NMBL.

At the top of the Menu window are the File, View, Help, and Modules submenus.





Under the submenus are a group of six buttons called the Main menu.  Clicking on a Main menu button will take you to the panel for that button.





Along the top of each panel, there is a set of tabs.  The leftmost tab is always the Help tab for that panel.  Shown here is the List tab under the Data panel.








